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1. Introduction

1.1 Preface
Thank you for choosing Medexpert® Arteriograph™. This state-of-the-art device and method enables
recording and analysing arterial pulse waves in an exceptionally easy, reliable and accurate way. With

this entirely new implementation of oscillometric method a complete arterial function evaluation can
be achieved.

1.2 Contents of the manual
This manual helps you in setting up and starting to use the Medexpert Arteriograph TL1 device as

well as installing and setting up the Medexpert Arteriograph Software up to versions 3.0.0.0.

Attention! Before first use, please read and understand this document carefully.

>

1.3 General information

e When active, the Device does not cause any electromagnetic disturbance and its immunity to
environmental effects is also sufficient. The measurement data are downloaded into the PC
through wireless infrared communication. The electromagnetic compatibility between the
Device and the PC is guaranteed (see Section 7.1 for details).

e To ensure the optimal performance and precise operation the Device should be maintained
at the manufacturer’s service every second year.

e The cuff and the Device itself can be cleaned with a wet cloth by making sure that no liquid
enter into the Device.

e The manufacturer’s products must be handled, stored, packaged, protected and shipped in
compliance with the general quality requirements.

Attention! Federal Law restricts this device to use by or on the order of a physician,
or other licensed practitioner (US only).

1.4 Guarantee

Medexpert Ltd. offers a two-year guarantee period for the Device. Any repair within or beyond the
guarantee period will be performed by Medexpert Ltd. at the company’s site as indicated above.



1.5 Warnings and precautions

A Caution!

Patient safety

The device has an integrated safety mechanism, which prevents the cuff pressure to exceed
300 mmHg. If however the inflation continues above this value or the pressurization lasts too
long, unplug the tube of the cuff from the device and remove the cuff from the subject.

Do not use the device on an arm, which is being injected with intravenous injection.

Do not use on neonates.

Device use

Only use with cuffs supplied by Medexpert Ltd. Use of cuffs supplied by a third party can lead
to erroneous measurement results.

Confirm blood pressure measurement with auscultation when erroneous results are
suspected.

Do not use a microwave device (e.g. mobile phone) near the unit during measurement.
Do not use the device when it is exposed to mechanical vibration (e.g. in vehicles).

Prevent the device to be exposed to direct sunlight, to get in contact with liquid or from
excessive mechanical impact.

Do not disassemble the device.




2. The Medexpert Arteriograph device

This section will give an introduction on the device along with installation information and operation
instructions.

2.1 The device at a glance

Figure 1 shows the front view of the device:

1. The name of the Device
2. Push button for entering two commands to control the Device, as per Section 2.4
3. Symbols standing for the above two commands
4. LCD
1
4
N .. Arteriograph
Vascular age
l ‘ E E H assessment
L Ll
SYS.mmHg DIA.mmHg PULSE/min
Z
WM medexpert =5 m ’
3 / ON/OFF 2x @

Figure 1
Figure 2 shows the rear view of the device:
5. Battery socket (cover removed)

6. Device label
7. Pneumatic connector

Figure 2



Figure 3 shows the device label. The meanings of the symbols are the following:

10.
11.
12.
13.
14.
15.
16.
17.

Name of the Device

Name of the Manufacturer

Range of ambient operating temperature

Manufacturing serial number

Applicable nominal range of supply voltage with the batteries

Year of manufacturing

Safety classification of electric shock protection (Classification: Patient side: BF)
Warning on the importance of reading this User Manual thoroughly

Certification mark as a guarantee of the Device’s conformity with EU requirements

/— 8 /_ °
(I ke '

16 sv[ ] TLAfA Cocasev-ee )

NNV N

Figure 3

Type ID of the Device

See Figure 4 for the side view of the Device:

18.

Infrared communication window

Figure 4

10

18



2.2 The accessories of the Device
Arteriograph has the following accessories:

e 4 pcs. AA size alkaline batteries

e Three D-ring cuffs of different sizes (see below)

e Medexpert Arteriograph Software installation CD

e Atape measure for measuring the jugulum — symphysis distance
e IrDA adapter kit (IrDA adapter, Driver CD, USB extension cable)
e A pouch with an integrated console for holding the IrDA adapter
e A User Manual

The cuff sizes are, as follows:

Cuff type Bladder dimensions Sleeve dimensions Arm circumference range
01 34x8cm 62x9cm 34-43 cm
02 26 x 8 cm 52x9cm 26-33cm
03 18 x6cm 38x7cm 18 -25cm

2.3 Installing the Device

Arteriograph is a battery operated device.
e Insert 4 durable alkaline AA batteries into the Device with taking care of the right polarity
(see Figure 3)
e Or insert 4 AA sized rechargeable Ni-MH or NiCd batteries as per the above instruction.
(Please note that new batteries must be pre-charged.)
0 For problem-free operation minimum 1,500 mAh chargeable Ni-MH or NiCd batteries
are recommended.

D@ LR6 1.5V (AA) O
© LR6 1.5V (AA) D]
Ij@ LR6 1.5V (AA) O
© LRe 1.5V (A8 D[]

Figure 3

Note: The clock circuits of the Device are fed by integrated NiCd HA 35 battery cells, therefore
the operation of the clock is independent from the AA battery supply.

Attention! If you do not intend to use the Device for a longer period of time, remove
the batteries and store them in a dry and cool place out of little children’s reach. Do
not expose them to intense heat because it may cause a short circuit. Regarding both
rechargeable and alkaline batteries, the policies of use and waste collection as
governed by detailed environmental and labour safety requirements are to be
considered.

>

11



Once the batteries are inserted in the Device, the following checks are performed automatically:

Voltage control of the batteries. The measured value appears on the 5 6,/

LCD for a few seconds. The supply voltage is sufficient if the
measured value is between 6.0 V and 5.4 V for alkaline batteries and
between 4.8 V and 4.6 V for rechargeable batteries.

If the voltage drops below 4.4V, the batteries must be replaced. A LOW Batt
warning symbol of low battery (crossed battery icon) appears on the

LCD.

The Device is ready for operation if the current PC time appears on D 09_39
the LCD.

2.4 Operation instructions

There is a single push button available for operating the Device (Section 2.1). The patient can use the
only push button for issuing a total of two commands.

By pressing the button shortly manual blood pressure measuring will start. Note! In this case
the Device performs blood pressure measurement without any arterial function (e.g. PWVao,
Aix) evaluation.

The Device can be turned off by pressing the button twice. In OFF OFF
state the device cannot be operated either manually or by PC. To
turn it on the button must be pressed twice again.

2.5 System (Infrared communication) setup

For installing the driver of the IrDA adapter please perform the following steps (the same description
can be found in the Installation Users Manual).

ukhwnN e

Attention! Please note that the IrDA adapter must not be plugged in the PC before
or during installation! To complete the driver installation the computer must be
restarted!

Insert the IrDA driver CD into the CD tray of your PC. The installation starts automatically.
Please choose your preferred language.

Click “Next” to run the procedure.

Click “Install” to begin the installation and to exit the install program.

Restart the computer to complete the install procedure. (Without restarting the PC the driver
will not work properly. All open data should be saved before restart!)

12



6. After restart plug in the IrDA adapter. (Do not plug in the adapter before or during the
installation!)

7. The IrDA device is ready to communicate.

The Device communicates with the PC using standard infrared protocol (IrDA) with a transmission

rate of 115,200bps. We recommend the IrDA communication to be set up by a person experienced in
wireless communication.

For connecting Arteriograph to the PC see Section 5.2.
Data transmission can only be initialized with the Arteriograph Software.

13



3. The software

3.1 Medexpert Arteriograph Software installation and setup
3.1.1 Preliminary information about the software

The Medexpert Arteriograph Software (Medexpert SW) is a Windows-based software. The common
Windows mouse operations are to be used in the program (left single-click, double click, drag, etc.).

Button and command names ending in ... indicate that a dialog window will open upon clicking on
those items.

Medexpert SW allows you to perform arterial function measurement, to print and share the
measurement report and to modify the measurement settings.
3.1.2 Minimum system requirements

e Pentium IV PC, 256MB memory, 2GB available HDD capacity, COROM, 1024*768 resolution,

e Windows 2000 operating system with Service Pack 4, Windows XP with Service Pack 2,
Windows Vista or Windows 7 installed,

e Active infrared port.

Although the Program can start in a less powerful environment, in that case we cannot take
responsibility for its fast and reliable operation.

14



3.1.3 Software Installation

For installing the Medexpert SW on the computer the user must have administrator privileges. After
the installation is completed, please visit our website (www.Medexpert.com) for the latest software
upgrades. Installation instructions for those can also be found on our site.

Step 1 Insert the CD into the CD tray of your PC. The installation procedure will start
automatically. In case it does not, start the installation by double-clicking the
setup.exe file on the disc with use of a file manager program.

Should a security warning pop up, simply press Run to start the installation

Open File - Security Warning =

The publisher could not be verified. Are you sure you want to
run this software?

Name: E:\settclin3000b.exe
E‘ Publisher: Unknown Publisher

Type: Application

From: E:\settclin3000b.exe

(%) Thsflls doss ot have s vald digeal signsture that verfies s
‘3 publisher. You shouid only run seftware from publishers you trust.
" How can | decide what software torun?

Step 2 To start the Setup Wizard, choose a preferred language for installation and click OK.

.Se\e:tgetup Language @

_Ad|  Select the language to use during the installation:
&

[Engish -

Step 3 The wizard starts with a welcome screen. Please close all the other running Windows
applications and click Next.

5 Setop verograph =—n |

Welcome to the Arteriograph
Setup Wizard

This wil il TersioMed Arieiograchs 310/0 0 bela on your
computer

o S s chon ol b apheations beden

Chek W 1o contrus, o Cancal 15 &t 5460

Moty | [ Cancel

15



Step 4 Select the components to be installed from the drop-down list. The type of
installation can either be Full or Upgrade.
When the preferred component is selected, click Next.

12 setup - Arteriograph ey = |

e
Witich components shoukd be nstalied 7

et wark fo instel. . et I
Irtal Chcke Mesd when you are ready b continue.

Full netslston

<hack [ Neas | [ cancel

Step 5 The following screen offers you to create an icon on the desktop. This task can be
deselected. Click Next to start the installation process.

L m—

Select Addtional Tasks
Which addtional tasks shoud b perfomed?

Select the adationsl lasks you woukd Bie Se0.p 1o perftem whde instaling Arienegrach
then chok Hee.

[EE—

o Crmatn 3 dasiteg wcen

< Back Hesd > (=

Step 6 The status of the automatic installation procedure can be tracked on a progress bar.
If you want to interrupt it, click Cancel.

1 Setup - Aresiograph =

bt allingg
Please wikt whie S0 inataly AREROTEN 0N YO COMEARE.

Extmcting fies
CA\Program Fles' TensioMed\ Anenograch'atind i

Step 7 When the automatic installation procedure is finished the following screen appears.
Click Finish to exit the Wizard and start the Arteriograph Software.

1) Setup - Aresiograph o] =] B

Completing the Arteriograph
Setup Wizard

S4tup has firushed rstaling Atencomch on your comgater. The
oyt ey b Lt by et o et abed sone

Chck: Finish tn et Setup.

V] Larch Meerisgrach

16



3.2 The software at a glance

To start the Program double-click the Arteriograph icon on your desktop, or use the gl
Windows Start Menu to navigate to the program in the Program Files.

A splash screen appears along with a login dialog window.
When started for the first time, simply press OK and the Program logs in the user with the default
“ARTERIOGRAM” login name. On every login after that, however, the user name must be specified.

Arteriograph

for professional users

|
b mJ

Manufactured by TensioMed Kft.
wl Koér str 2/d 1103-Budapest, Hungary

The program window appears with the following components. (For a better understanding the
picture below shows the program window after a completed measurement.)

1. Menu bar
2. Toolbar
3. Examinations window
4. Results field
5. Patient details field
6. Data window
i 8
\l:) : iograph - You are kogged in a3 ARTERIOGRAM . e
Eﬁﬁu ook _Informaon _
, > JI0EE BlEd & s (5 U [
K e shept W0mcm v Y wiscompressone 2 v Bassioa: 0 i Rese | [ [ Avometcansns®s [ D [ Cuser
PATIENT DETAILS [ Tesnt - 5
Fust name Beteg Duste of Bath 01.01.1975 )
3 P>
< 6
Aix brachial | 121
51.2 [%]
.\n ;?;«L} 3 |
ED
||2|m[m‘} 96 \—AJ\WM
125 [ms]
R
PWVao " |
::?isl!:\:"::i, 60
.21 [ms]
PPao
28.7 [mmHg)
SHPao I e |
117 [mmHg] | ) l b
m.m.m-nu:-MIM»w. .
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3.2.1 The Menu of the Program

The menu bar of the software can be found under the title bar and contains the menu items through
which all the major functions of the program can be accessed.

The File Menu

The basic functions of Medexpert SW can be accessed through the File J'[i_k’;“::“’“;j:";“f"':"w:““"""""““‘“"”"“"‘”

menu. You can enter new patients, open, edit or delete existing e wn g (B (X

database records, save the result of an analysis; furthermore edit, print Sve et Qnen  prem ""* =
. . Edit repert I r:‘u n;_':"

and send medical reports, as well as log out and exit. T f

Send POF repart

Exit

The View Menu

The View Menu enables you to choose to display the pulse waves B o S Yo DN ]
recorded or the maximum amplitudes of the oscillatory signals at each | |
cuff pressure step (deflated stepwise with 10 mmHg) during blood
pressure measurement. Furthermore you can set the scale both &
horizontally and vertically, hide the Toolbar, and get information about !
the currently studied patient.

Cetefl i srany [
CtrleF2

CirleF3 1

p Farmiy sm

Fusl name

The Tools Menu

The Tools Menu enables you to start automatic pulse wave data |7 TVt e tosuslossed e ARTEROGHM

File Yiew [Tools| Information

collection by means of the Arteriograph Device, as well as interrupt an || [ e
ongoing data collection process. Previous versions of databases can be [|"™™  cupeiow susbisc ssimpon i

Erammstons

converted and imported into the new database format; furthermore | &g ™™
exports and backups of the actual database can be created. All the options
Program and Device settings can also be accessed and modified through

this Menu.

3.2.2 The Toolbar of the Program

The toolbar can be found under the menu bar and contains icons, which allow direct access to the
major functions of the program. The Toolbar can be displayed or hidden by the Toolbar command of
the View Menu.

3.2.3 The examinations window

All the previous — if there are any — examinations of the selected patient are listed here by the date
and time of recording.

3.2.4 The results block

The calculated hemodynamic parameters are displayed here when an analysis of measurement data
is performed (automatically or manually).

18



3.2.5 Patient details field

The name and date of birth of the patient are displayed in this field.

3.2.6 The measurement data window

During the measurement the data are displayed here real-time in the form of non-calibrated
pressure curves (oscillations) as recorded by the device. The recorded and saved pressure waves can
be opened and displayed at any later time. The User can also select to display the amplitudes of the
oscillometric curves throughout the blood pressure measurement phase, or the estimated vascular
age of the patient based on the arterial function assessment.

3.3 First step — Register a user

If the program is used by several users with different groups of patients, it may be necessary that
users can access their own respective patients’ data only after login. To this end a new user will have
to register in the database by specifying the name and login.

Medexpert SW can be used with the default login of “ARTERIOGRAM”; it is, however highly
recommended to create and use your own user login.

Registration of a new user

To register a new user, open the Options... window under the Tools menu and select the
Users tab. To enter a new user click on Add New and then enter the first and family names of
the user and specify a login name (user ID). Click Add to register the new user in the database
or click Cancel to interrupt the registration. The new user can log in with the login name
specified.

Note! The registered users’ data cannot be edited.

Oplons.. i
Systom || Users || Pintnd sopert
Lless s
Fust name:
Family o
Liagin rame (ser D}
Llse st
Aekd Hew
ok Kancel 2 med

How to delete registered users
To delete registered users, select Options... under Tools and click on the Users tab in the

pop-up window. The Delete button can be used for deleting a pre-selected item from the
users list. In case the list contains only one user, the Delete function will not be available.

19



4. Performing a single blood pressure measurement

The Medexpert Arteriograph device can be used as a simple automatic blood pressure meter. (For
this function no computer is needed.)

4.1 Patient preparation

Sitting position is recommended for standard blood pressure measurement. The patient should be
comfortably seated with the legs uncrossed and the back and arm supported. The cuff on the upper
arm should be at the level of the heart.
Allow the patient to sit in a relaxed state for at least 5 minutes before the measurement. Ensure
optimal room temperature and eliminate excessive background noise.
Choose a cuff of appropriate size by considering the followings:

e The length of the inflatable bladder of the cuff should be at least 80% of upper arm

circumference.

e The width of the inflatable bladder of the cuff should be at least 40% of upper arm length.

(Please read and follow the latest guidelines on blood pressure measurement.)

4.2 Performing the measurement
To operate Arteriograph first install the device (see Section 2.3). There is a single push button

(Section 2.1) available for operating the Device. The measured values and the status of the Device
are shown on the LCD.

e The Device is ready for operation if the current PC time D 09—39
appears on the LCD.

By pressing the button shortly manual blood pressure measuring will start.

Note: In this case the Device performs blood pressure measurement without arterial function
(e.g. PWVao, Aix) evaluation.

By doing so, the current time will disappear from the display and then:

e The LCD test pattern is displayed, E%E}gg%g%

e The supply voltage is checked 5 5,/

e The Device calibrates itself by setting the zero pressure C‘AL 0

20



The measurement starts with the inflation of the cuff. This procedure
is indicated by an arrowhead pointing upwards.

During deflation an arrowhead pointing downwards indicates the
procedure.

When measurement is completed, the Device displays the systolic and
diastolic values,

and then the heart rate.

The measuring process can be disrupted any time by a single press on
the button. The text “OFF” will appear and remain visible for about 5
seconds on the display. Thereafter the time is displayed again, which
indicates the ready-to-operate status for another manual or
programmed measurement.

4.3 Acoustic signals

O 87

v 69

128/96

PUL 68

OFF

When the Device is active, a gentle acoustic signal is emitted when its button is pressed down.

21



5. Performing pulse wave recording and analysis

Pulse wave registration can only be initialized by Medexpert SW that is running on a PC with
wireless infrared data transmission link to the Device (in this case the button of the device should not
be used)!

The oscillatory signals recorded during the whole measuring process are displayed real-time on the
PC screen.

5.1 Hemodynamic parameters measured by the Arteriograph
The following hemodynamic parameters are computed during the measurement:
Sys — Brachial systolic blood pressure (mmHg)
Dia — Brachial diastolic blood pressure (mmHg)
HR — Heart Rate (beat/min)

MAP — Mean Arterial Pressure (mmHg)
As calculated from the brachial systolic and diastolic blood pressure.
MAP = diastolic blood pressure + (systolic — diastolic blood pressure)/3

PP — Brachial Pulse Pressure (mmHg)
PP is the difference between the systolic and diastolic blood pressure in mmHg.

ABI — Ankle — Brachial Index (Dimensionless index)
The ratio of the ankle systolic blood pressure and brachial systolic blood pressure values.

Aix brachial — brachial augmentation index (%)

Augmentation index = The difference between the amplitudes of the late (backward) systolic wave
(P,) and the early (forward) systolic wave (P;) over the pulse pressure (PP) and multiplied with 100
Aix = (P,-P;)/PP*100

Aix aortic — central augmentation index (%)
Calculated on the basis of a very strong (R>0.9) linear relationship between the brachial and central
augmentation index.

ED - Ejection Duration of the left ventricle (ms)
It is the period of the mechanical systole, i.e. the time-span between the opening and closing of the
aortic valves.

RT — Return time (ms)
The RT is the time of the pulse wave travelling from the aortic root to the bifurcation and back.

PWVao - aortic pulse wave velocity (m/s)

The velocity of the pulse wave in the aorta.

This is calculated from the travelled distance (measured as the suprasternal notch — pubic bone
distance) of the pulse wave in the aorta divided by the measured transit time (RT/2).
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SD PWVao (m/s)
A parameter informing about the quality of the measurement. The PWVao is calculated from each
pulse recorded and the standard deviation is featured. For more details, see Section 5.4.4.1.

SBPao — central systolic blood pressure (mmHg)
Calculated on the basis of the physiological relationship between diastolic BP, mean arterial BP,
peripheral and central Aix and central SBP.

PPao — central pulse pressure (mmHg)
The difference between aortic systolic and diastolic BP values.

DRA - Diastolic Reflection Area (Dimensionless index)

DRA provides information about the quality of diastolic filling in the coronary arteries, taking into
consideration the duration of the diastole and the area between the expected (theoretical) diastolic
pressure curve without reflection and the truly measured diastolic curve with reflection.

SAI — Systolic Area Index (%)
SAl is the systolic part of the area under the entire pulse curve.

DAI - Diastolic Area Index (%)
DAl is the diastolic part of the area under the entire pulse curve.

5.2 System setup

Enable the infrared communication on the PC (see Section 2.5). Place the Device by directing its
infrared window towards the infrared port of the PC.

Please make sure that the infrared window of the Device and the IrDA adapter plugged into the PC
are facing each other, nothing blocks the path of the ray and that the device and the adapter are on
the same level. The distance between the Device and the sensor cannot be more than 1 m.

Then — once the device moves into the operating range of the infrared communication adapter — the
Device automatically connects to the PC.

To ensure optimal conditions for IrDA communication please use the supplied pouch with integrated
console for holding the IrDA adapter (see Figure 6). Insert the device into the pouch with its infrared
window pointing towards the console. The IrDA adapter can be fastened on the console with use of
the velcro strip attached on each item.

Attention! Direct light (either sunlight or artificial light) or mirroring surfaces (e.g.
glass table) can cause infrared communication malfunction.

Other infrared devices (e.g. mobile phone) operating in the range of the system also
may cause error.
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Console

Figure 6

Infrared communication takes place in the following way: when an active —i.e.
enabled on the PC - infrared communication adapter moves in the Device’s ‘ [
ir dH

efficient range, the Device and the PC will automatically connect. The sign
shown by the Figure on the right appears on the LCD. No actual data
transmission takes place yet.

An icon appears in the system tray of the PC indicating a detected infrared connection. By default it is
accompanied with a Windows sound effect.
Data transfer can only be initiated with use of the Medexpert SW.

5.3 Patient preparation

Wrap the cuff around the dominant upper arm. When doing this procedure, please consider the
followings:

e Use the cuff suggested by the software (see Section 5.4.2)

e Make sure that the cuff is tightened properly, without causing harm to the patient. The cuff
should fit the patient’s arm evenly. Tightness is sufficient if your finger cannot or can only
hardly be inserted under the cuff.

e Make sure that the patient’s skin is not pinched by the cuff.

Note: If the cuff is too loose or big, the SW does not provide measurement results and gives an

error message (“Small amplitudes!”).
The cuff should not contact the patient’s chest during the measurement because the respiratory
movements may cause pressure alterations and artefacts in the cuff.

According to the guidelines for measuring arterial function routinely the supine position is
recommended for measurements. In case the examination is performed while the patient is seated,
indicate this fact in the “Comment” field of the SW when the patient’s data are entered.
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e Place the cuff in a way that the hose is in anterior position.

e To avoid the irritation of the skin a long-sleeved shirt made of some thin material can be
worn under the cuff.

e Connect the hose of the cuff to the air connector of the Device. For this, push the plug on the
hose into the air connector of the device and twist the plug slightly until it securely clicks.
Make sure that the cuff is properly attached by checking the tightness of the connection.

e Measure the suprasternal notch — pubic bone distance (Jug-Sy) with use of the supplied tape
measure.

Note: The suprasternal notch (jugulum) — pubic bone (symphysis) distance should be measured in
a straight line. Measuring on the body surface can lead to overestimation (e.g. in case of obese

Y//@h
%/m

e Ensure optimal measuring conditions:

0 Speaking, muscle movements, especially the movement of arm muscles must be avoided
as these activities significantly increase the measuring time, may result in measurement
failure or may reduce the precision rate thereof. Muscle movements (tremor) distort the
form of the measured pulse wave and render its evaluation impossible.

0 Within 3 hours before the examination the patient should not consume a greater
amount of food, drink coffee or smoke. Additionally within 10 hours before the
examination alcohol consumption should be avoided.

0 The patient should not sleep during the measuring phase.

0 At least a ten-minute period of physical and mental rest is required before the
examination.

0 Any circumstance (e.g. noise, phone ringing, persons’” movement in the examining room)
that may disturb the patient’s calm must be avoided.

0 Should “White Coat Effect” be detected the measurement must be repeated several
times with a few minutes’ intervals or the examination should be repeated in another
time.
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5.4 Performing the measurement

To start the Program double-click the Arteriograph icon on the desktop or use the Windows Start
Menu to navigate to the program. Log in to the software with the previously specified user name
(see Section 3.3). (When started for the first time, the Program logs in the user with the default
“ARTERIOGRAM” login name. On every login after that, however, the user name must be specified.)

In case a wrong or non-existent user name is given, the Program will offer the default name.

2 Warning &J

& Login is incorrect!
Do you wish to enter with the standard login name?

[ Yes | o ] ¥8 med

5.4.1 Device and measurement setup
Before starting the measurement changing or checking setup parameters may be needed.

For setting up the Device select Options... under the Tools menu.

Options... ]
System| Users | Printed repant
Iritial rflation pressure Dffset of systolic pressure level
Previous BP value + 35mmHg 10mrHa<= A0 <120 mHg
Fised initialinflation pressure [mmHg] 180
Dffset of diastolic pressure level
Diate and time of the device AmmHae 0 (=120 e
Downlgading inta the device Data ransfer time at dia and sys pressure level
| S Tsec<= B «=10sec
Data Intertace: GDT
GDT Directory Brovise.
Local Name TSM_ARGZ Local Shat Name TARG
Remate Name Remate Short Name:
Caloulation of Ankle Brachial Index Commurication port: COM 28
User defined parameter
Plint preview Progiam language  Date format
i Englsh [ T
‘ OK H Cancel S med

In the pop-up window the following parameters can be set in the System tab:

e Initial inflation pressure is the value Arteriograph inflates the cuff to when starting a blood
pressure measurement. This can be set as a fixed or a relative value. In this latter case the
Device adds 35 mmHg to the systolic value measured previously and inflates the cuff to this
pressure. The relative value is the default setting.

o Offset of systolic pressure level determines the value which is added to the measured
systolic pressure in order to obtain the suprasystolic pressure step where the Device will
record pulse wave data. 35mmHg is the default setting, which means that data will be
collected at a pressure level of the measured systolic value + 35mmHg. For diagnostic
examinations this value should not be set lower than 35 mmHg.

o Offset of diastolic pressure level determines the value which is added to the measured
diastolic pressure in order to obtain the pressure step where the Device will record diastolic
pulse wave data (volume curve). Zero (0) is the default setting, which means that data will be
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collected at the pressure step corresponding to the measured diastolic value. Diagnostic
examinations should not deviate from this value.

e Data transfer time at dia and sys pressure level determines the time-span (in seconds) of
pulse wave data collection at the above-specified pressure levels. The default value is 8 sec.
Diagnostic examinations may deviate from this value in the 7-10 sec range.

e Data interface: GDT; The GDT interface enables data transfer between medical devices and
general practice IT systems according to the standard produced by the German Quality
Assurance Software (QMS). A practice software system that supports GDT is required for the
communication. For setting up the GDT interface, please read and follow the GDT interface
manual located on the Arteriograph installation CD.

e Calculation of Ankle Brachial Index; if selected, Ankle-Brachial Index is calculated. For this
the ankle systolic blood pressure has to be measured before the pulse wave recording.

e Communication port; A default communication port number can be defined here. This way
the user can avoid the more time consuming process of automatic port search. (The proper
port number can be checked under Control Panel -> Telephones and modems -> Modems.) If
this field is left blank, the software performs an automatic port search when starting the
measurement. This process may take up to one minute.

e User defined parameter; One new parameter can be added to the patient’s data-set through
this function. Enter the name of the parameter into the input field (the parameter will be
displayed in the Patient details field on the print-out, see 5.4.5.2) and press Set.

Note: A new parameter can be added to a patient’s data only once and cannot be modified
or deleted later. The new parameter wil automatically be added to all the patients in the
database. After setting it into either a new patient’s data or an existing patient’s data, the
patient characteristics will feature this newly specified parameter, as well.

Non-Device-specific settings:

e Program language; the language of the Arteriograph SW can be selected. The change only
takes place upon the next SW start.

e Date format; one of the following date formats can be selected: Year-month-day, day-
month-year, and month-day-year.

Default settings can be restored by clicking on Default Settings. The settings must be downloaded
into the Device to take effect. For this use the Downloading into the Device button.

The download of the settings to the Device can be tracked on the screen. The C‘O/V/VEC‘T
text “CONNECT” will be displayed on the LCD of the Device while communication
is in progress.

Successful data download will be confirmed on the PC.

Note: The downloaded settings cannot be cancelled. They can be overwritten through re-
programming.
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5.4.2 Select a patient
5.4.2.1 How to select an existing patient

- After logging in to the program use the Open command in the File menu or click on the Open
button (see on the left) on the toolbar for displaying the list of the patients that belong to the

user logged in. Find and select the patient you are interested in (by double-clicking on the row which

contains the patient’s details or by highlighting the row with a single click and then click on OK).

Patiest list i

Family name First nama Date of Binh_gd-mm-yyyy) [
Teszt et 01011975

Search by

Ot of Brth
(]

"3 Lancel mad

The selected patient’s full name and date of birth are displayed in the Patient Details block under the
Toolbar. In addition, the patient’s previous examinations will also appear in a list, if there are any.

) Tensiohhed™ Artericaeigh - You e kgged i it ARTERIOGRAM | Em———
Ble Wew look [nfcemation
sl 2| A ) medex
W i g Amafem Y i comprestion 2 v Daeine 0] Pese B Autonatic anabyin 535 D[ B Comnen
[— ATIENT DETAIL [— Teat
Bt Tine. Fast nrn Bete D of B 01.01.1975
UGN, 14

5.4.2.1.1 How to modify a patient’s data

Select the patient (as described above) whose data you wish to modify (by a single click in the
Patients’ List) and press Edit. Click on OK to save the modified data.

5.4.2.1.2 How to search for a patient

In case there is a great number of patients, a particular patient can be found by using the search
function of the software.

For a quick search click anywhere in the patient list and type in the initials of the family name of the
given patient. The quick search is not case sensitive.

An advanced search can be done by name or date of birth with use of the “Search for” function.
Select “Name”, “Date of Birth” or “ID” and type in the name, date or ID you want to find into the
“Search for” field. This function is case sensitive. When searching by name, the search is made in
both the first and last names and even a part of the name can be searched for not necessarily
including the initial of the name.
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5.4.2.2 How to enter a new patient’s data

If you want to enter a new patient into the database, select the New patient command in the

File menu or click on the New patient button (see on the left) on the Toolbar. For entering a
new patient only the date of birth, the height, the patient’s jugulum — symphysis (JUG-SY) distance
and the upper arm circumference are required to be filled out. The jugulum — symphysis distance and
the upper arm circumference can be measured by means of the tape measure provided as an
accessory (see Section 5.3). The former data is necessary for calculating the pulse wave velocity while
the latter one is needed for calculating the proper cuff size. After filling out the arm circumference
field the suggested cuff type and its size will automatically appear next to it.

Note: To achieve good measurement quality always use the cuff suggested by the software.

The cholesterol unit can be selected from a drop-down list (mmol/l or mg/dl).

The Comment field is advised to be filled out with important information on the measuring
conditions (e.g. the measuring position, pregnancy).

Fill out the Risk profile field with information on the known cardiovascular risk factors, such as family
history, duration and frequency of smoking, etc.

Bagen

Commen
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5.4.3 Maedical Examination with Medexpert Arteriograph

B cTART To start a single measurement select PW read under Tools or press the START button
__ on the toolbar.

s To start a scheduled sequence of measurements click the Repeated Measurements...

) button on the toolbar. In the dialog window the length of the test and the measurement
frequency can be set. To start the measurements, click Start. The measurement process can be
interrupted by pressing the Stop button.

Repeated measurements

Length of test: hd @ Start
Frequency: 5 i - Stop

| Save results automatically

Murnber of remaining measurements: 3

Cancel ] Sl mede

When starting a measurement a confirmation window will pop up with some important
measurement information. If the listed data are correct, press Yes to start the measurement process.
If these data need to be modified, press No and edit the patient’s characteristics (see Section
5.4.2.1.1).

# Confirmation &J

@ Arm circumference: 26 cm
Suggested cuff type: 2 (bls: 26x8cm)
Operator's name: ARTERIOGRAM

No B8 med

The measurement process starts with the SW connecting to the Arteriograph device. The scanning of
the active ports and the communication process can be tracked on the monitor. While this
communication is in progress, “CONNECT” (See Section 5.4.1) will appear on the LCD of the Device.

After a short time measurement will start automatically by performing a blood pressure
measurement in the first phase. During measurement the recorded pulse wave curves can be tracked
on the screen.

In the second phase the pulse wave recording for pulse waveform analysis is performed.

e First the Device will inflate back to the diastolic pressure level and register the pulse waves
for a previously determined duration (8 sec by default).

e Second, the Device inflates further to the suprasystolic pressure level (by default to the
measured systolic value + 35mmHg) occluding the brachial artery completely in this way and
registers the pulse waves for a previously determined duration (8 sec by default).

(The time and pressure offset values can be modified through the system settings function in the
above-described manner. See Section 5.4.1)

During the measurement there is a real-time data transfer enabling the user to see the recorded
oscillatory waves on the screen. At the end of the examination the Device transmits the blood
pressure values to the PC, as well. The SW displays the followings: systolic and diastolic blood
pressure values, heart rate, MAP, pulse pressure, and the entire registered pulse wave curve.
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| @ghnrt | If you want to interrupt the measurement use the Abort command. An

Abort button appears automatically next to the PW button when starting a
measurement, and the same command can be found under the Tools menu. Please note that this
function only disrupts the data collection procedure of the software and does not affect the
operation of the Device. To interrupt a measurement on the device the push button of the
Medexpert Arteriograph must also be pressed once.

If the Calculation of Ankle — Brachial Index was selected (See Section 5.4.1) a dialog window appears
after the suprasystolic pulse wave recording phase is completed. Enter the formerly measured ankle
systolic blood pressure here and press OK. The calculated value will appear under the blood pressure
values in the Results field (see Section 3.2). If calculation of ABI is not needed or the ankle blood
pressure could not be measured, press Cancel.

Measurement of the ankle blood pressure is advised to be performed preceding the pulse wave
recording. For measuring systolic blood pressure on the ankle, use of Doppler technique is suggested.
However, if it is not available blood pressure measurement can also be performed on the ankle with
Medexpert Arteriograph, using the simple blood pressure measurement function (see Section 4). In
the latter case please use the appropriate cuff size (the same rules apply as for arm cuffs, see Section
4.1).

Calculation of Ankle Brachial Index |t ]
Systolic blood pressure measured on the ankle: mmHg
| 0K “ Cancel ¥ meds

After the measurement is completed the automatically calculated blood pressure and arterial
function data appear in the Results field (see Section 3.2), while the recorded pulse wave curves are
displayed in the Data window (see Section 3.2).

TeraioMed™ Arterigraph - You are logged in a5 ARTERIOGRAM ol i |
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im0 . .
125 [ms] [ A Jiily
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#8.7 [mmig]

1117 [mmbig]
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Every examination is saved automatically. An already saved examination can be deleted by selecting
the row, which contains its date and time in the Examinations list and then pressing the Delete
button on the keyboard.
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5.4.4 Quality control of the measurement

Conditions (movement, arrhythmia, respiration, etc.) disturbing the measuring process may distort
the shape of the recorded pulse wave, which may result in false hemodynamic parameter values.
After the measurement is completed its quality should be checked to decide whether the result of
the subsequent analysis can be accepted.

5.4.4.1 Quality control index: the SD PWVao

SD PWVao (see Section 5.1) is the standard deviation of the PWVao values calculated from the pulse
waves that could be analysed by the algorithm of the software. This variable shows how much the
PWVao data of each analysed pulse curve differ, therefore reflects on the identity of the recorded
pulse wave forms. Large deviation of the measured data shows some disturbance in the
measurement.

Normal SD - ;msi "
51 [cm] 54
If the SD PWVao is greater than or equal to 0 and less than or equal to 1.0 m/s, P
the measurement is considered to be of good quality. 020 el 4 [A
1.08
54.3 [mmHag]
High SD
95
125 [ms]

If the SD PWVao (SD) is greater than 1.0 m/s, the measurement is considered
to be of unacceptable quality and the results of the current analysis should be
rejected. The SD appears in red colour in the Results field to warn the User on G5 (Tv/er)
the quality problem. For advanced users the use of manual evaluation (see 0005 (L]

Section 5.4.5) can help to find a good quality sequence in the suprasystolic

54 [cm] 54

. . . 4101 H
measurement phase. If manual evaluation is still not acceptable, the —
measurement should be repeated.

No SD 107
80 [ms]

If the automatic analysis calculated arterial function data but no SD PWVao, 54[cm] |54

then only one evaluable pulse curve could be found in the suprasystolic DS [L/ed) |
measurement sequence. The SD appears in red colour in the Results field to — [ms]

warn the User on the quality problem. The results of the analysis should be
rejected and the measurement should be repeated.

59.5 [mmHag]

5.4.4.2 Quality control by visual inspection

Although the SD PWVao performs considerably well in detecting erroneous measurements, further
visual inspection can help categorizing the type of the error. Consequently it can be avoided when
repeating the measurement. By visual inspection disturbances can also be detected in measurements
that were categorized to be of good quality by the SD PWVao parameter.
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Improper cuff size or tightness

In this case no early and late systolic wave can be differentiated on the pulse wave form. Due to
the larger cuff size or the looser fit, the cuff system loses its sensitivity to pick up higher
frequency components of the oscillatory waves. This often leads to recording small amplitudes,
which case is always indicated by the software with a warning message.

How to recognize: no reflected component can be seen on the wave.
How to avoid: use a smaller cuff or tighten the cuff according to the instructions (see Section

5.3).

TergioMed™ Artencgraph - You are logged in a5 ARTERIOGRAM [ ] |
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Arrhythmia

The oscillatory measurement method is highly affected by arrhythmia. In such cases the beat-to-
beat variance of the pulse wave forms renders the analysis inaccurate.

How to recognize: the heart beats do not show regularity.

How to avoid: this condition cannot be affected by the examiner. Manual evaluation (see Section
5.4.5) can help to find a regular sequence in the suprasystolic measurement phase.
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Tremor or mechanical vibration

Tremor introduces an unwanted high frequency noise into the measurement. This often leads to

unrecognizable and not evaluable waveforms.

How to recognize: the measurement is noisy, a sawtooth-like signal is superimposed to the pulse

waves.

How to avoid: tremor cannot be affected by the examiner. Make sure, however that the patient
is isolated from external mechanical vibration (e.g. do not place the patient’s arm onto a

vibrating machine, like a PC).
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Movement artefacts

Movement artefacts distort the waveforms and lead either to not analysable measurements or

to results with inflated variation.

How to recognize: the baseline of the recording undulates or some pulse waves noticeably differ

from the others.

How to avoid: emphatically ask the patient not to move. Manual evaluation (see Section 5.4.5)
can help to find a regular sequence in the suprasystolic measurement phase.
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5.4.5 How to analyse the data

Select a patient and an examination thereof you intend to analyse. You have two evaluation options
available: automatic and manual.

The former is fast and convenient. Automatic evaluation will take
place immediately after a patient’s examination is selected. The
same can be achieved by clicking first on Automatic analysis S35 (for suprasystolic data) and then on
button D (for diastolic data) after the results have been displayed. Most of the hemodynamic
parameters described above (Section 5.1) will appear in the results window, under the list of
examinations. During the automatic analysis the algorithm will analyse pulse waves of several
heartbeats and calculate the mean of the results as well as the standard deviation of the PWVao (SD
PWVao). However if there is only one evaluable pulse wave, no SD PWVao can be calculated.

| Automatic analyzis 535 | | B

For manual evaluation you have to go to the end of the whole measurement sequence by using the
horizontal scroll bar at the bottom of the graphic area. (The pulse wave curves recorded at the
suprasystolic pressure step are located at the end of the measurement sequence.) You can use the
mouse for selecting arbitrarily any (or several) pulse wave recorded at the diastolic and suprasystolic
pressure steps. Curves can be selected even from those recorded in the blood pressure measuring
phase, but only that were recorded above the measured systole or in a 10 mmHg range of the
measured diastole.

To select a series of pulse waves (or a single one) highlight (hold down the left mouse button while
moving the mouse) those from the beginning to the end of the sequence. Only pulses (i.e. heart
cycles) that are highlighted in their entirety are included in the analysis (see the picture below).
e When several pulse waves are selected for manual analysis the results are displayed in the
same way as in a normal automatic analysis.
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e In case a pulse wave of only a single heartbeat is highlighted — of either those that were
registered at the suprasystolic or those registered at the diastolic pressure level — it will
appear in a separate window displayed on the millimetre net. (Please note that in this case
SD PWVao cannot be calculated.)
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The said separate window can have two kinds of content:

0 The one highlighted pulse wave at the suprasystolic pressure step is represented by a
green curve. There are four markers shown on the curve and these markers indicate
the location of the incident wave’s highest point, the location of the first reflected
wave’s foot and peak, and the point of dicrotic notch (ED value, i.e. the closing of the
aorta valve).
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0 When selecting only one pulse wave at the pressure step corresponding to the
diastolic value several curves appear in the window: the original pulse wave
(represented by a red curve), the systolic component (green) and the diastolic wave
component (black). The curve shows two markers indicating — from left to right — the
locations of the peak of the systolic wave and the start of the diastolic wave.
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With use of the tools in the separate window the single pulse wave can further be examined.

The curve can be enlarged and reduced in size within pre-set limits; see the relevant value of this in
the upper left-hand corner of the window. Furthermore, you can examine the curves from point to
point by means of a cursor that can be activated.

The window can be closed separately.

Characteristic points of the pulse wave curve are marked in this window. Blank blue circles represent
the first and reflected wave peaks and the ejection duration (Dicrotic notch), respectively. Filled red
dot represents the calculated return time. The return time is calculated as the time difference
between specific characteristic points of the curve, therefore it does not necessarily fall to a
characteristic point itself.

21 |
time: 200 [ms]
|amplitude: 113.5

=

+,l" _,1‘ 'Q' @I % Close

Note: Results of the evaluation are not saved automatically. For saving the results into the
database the Save results... command should be used. This allows the examiner to save the
results of only those measurements that are of good enough quality to be exported later.

E The findings of the evaluation can be saved into the database by selecting Save results... in the
=

File menu or by clicking the Save results... button on the toolbar. Any previous result will be
overwritten.

21l Confirmation &J

@ Results already exist! Overwrite?

G e

This even allows saving results different from the ones calculated by the automatic evaluation.

When an examination is opened it appears with the formerly saved arterial stiffness results. If no
result is saved, the software displays the results of the automatic evaluation. However, in this latter
case no values will be exported with the Export command (see Section 5.4.7).
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5.4.5.1 Tools for visual inspection

X axis step / Horizontal axis

The scale of the horizontal, time axis of the pulse wave curve as
displayed on the millimetre net can be set from 10 ms/cm to
1,600 ms/cm in the pre-defined steps. This function can be accessed directly from the toolbar (X axis
step) or by selecting a value under Horizontal axis in the View menu.

# awiz step: 200 mzdcm

Y axis compression / Vertical axis compression

Here the vertical, amplitude axis of the pulse wave curve, as
displayed on the millimetre net, can be set. The set value indicates
the vertical compression rate of the curve. In case the set value is 1, the curve will be displayed in full
size. This function can be accessed directly from the toolbar (Y axis step) or by selecting a value
under Vertical axis compression in the View menu.

Y &dis COmpresion:

Baseline shift
' = The pulse wave curve on the millimetre net can be
Eazeline: o = _Fieset
_ moved upwards or downwards relative to the zero line.
The original position can be restored by clicking on the Reset button.

View pressure curve

To display the actual cuff pressure values, press the View pressure curve button on the
i toolbar. When it is on, the baseline cuff pressure can be seen during the whole measurement
on the millimetre net.

Cursor

ETT Use the Cursor function for reading the co-ordinates of the oscillatory signal (pulse
= waves) and the value of the baseline cuff pressure (if the View pressure curve function

is on).

= When the button is on the control tools appear. With use of these the
PP

cursor can be moved in small or big steps.

Note: The Cursor feature is only available at the default X axis step of 200 ms/cm.

Note: The oscillatory signals are not calibrated and therefore should not be considered to
represent true pressure values.
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The above mentioned functions are illustrated on the picture below.
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5.4.5.2 Oscillation amplitudes during blood pressure measurement

By clicking on the Amps — pressure values tab of the measurement window the maximum
amplitudes of the oscillations recorded during the blood pressure measuring phase appear. The same
function can be accessed by selecting the Amps — pressure values option under View menu.

By using this feature the quality of blood pressure measurement can be evaluated visually.

1) Terviohed™ Aerograph - Yeu are logged in as ARTERIOGRAM o ]|
| Bleiew Took _Infeematicn |
D=l Bl = (] (g ] 2 mederport [l
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Pk e | Arog - peaconas vhsns | el dgm amsmtssmant

il 1% il =0 3 kg
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5.4.5.3 Vascular age assessment

By clicking on the Vascular age assessment tab of the measurement window the estimated vascular
age of the measured patient can be displayed. The same function can be accessed by selecting the
Vascular age assessment command under View menu.

This tab shows the Age — PWVao relationship with smoothed reference percentile curves.

Note: Percentile is a value below which a certain percentage of the known measurements fall;
e.g. the 75" percentile is the value below which 75% of the observations can be found. Age-
specific percentile curves show certain percentiles in different ages.

Note: The reference curves were derived from a healthy central - European population including
approx. 10 000 subjects.

The current measurement is indicated with a coloured dot in the graph, with the colour depending
on which range the measured PWVao value falls. The ranges are as follows:
e Normal — green colour. The measured value is lower than or equal to the 50" percentile for
that specific age group.
e Elevated — yellow colour. The measured value is higher than the 50" percentile but lower
than or equal to the 90™ percentile for that specific age group.
e High —red colour. The measured value is higher than the 90" percentile for that specific age

IT) Tersiohed™ Arteriograph - You are kgged in a3 ARTERIGGRAM [E=p——)
Ble Yiew Took [nfermation
e HE = (fmswm] 5= & med
¥ e camgemsion
Exsmanatons PATIEHT DETAIL Tardyrame Tosat
Dt / Time Fit name Beteg D of B L0175

Py o]

prsstely 10000 st pertconnd in CantiahEunpsan (ogulation ® oo St parcantis

5.4.6 The measurement Report

The Report is a printed summary of the measurement results. It includes patient details, all the
calculated hemodynamic parameters, characteristic pressure curves and vascular age assessment.

The following functions are only enabled if an examination of a patient has been selected.
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5.4.6.1 Edit the Report

To edit the Report, press the Edit report... button on the toolbar or select the Edit report

command under the File menu. In the report window you can enter your medical advice /
treatment suggestion, which can be saved by clicking on Save. The current date can be inserted to
the report by using the Insert date button. The edited Report will appear on the third page of the
print-out.

Lait report P

bese e

Note: The report is assigned to a specific examination, and can be modified later. For other
measurements of the patient this medical advice will not be saved or displayed.

To display institutional data on the printed Report, select Options under Tools. In the dialog box
choose the Printed Report tab where you can specify the following:

e Doctor’s identification data

e Department details

e Operator’'s name
Department details along with the doctor’s name and registration number will appear in the footer
of the printed Report. These data are user specific and therefore will appear on the report of every
patient of the user.
The Operator’s name will appear in the Study data section of the printed report. It is measurement
specific, therefore can be modified for each measurement. By default the Operator’s name is the
login name of the User. The Operator’s name for the default user (ARTERIOGRAM) cannot be
modified.

Options.. L
Syatem | Usery | Porked iepon
Deetors werttieseon

Famiy rme:

Teleghone. Mokle phore
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5.4.6.2 Print the Report

You can print out a Report by choosing Print preview and print under the File menu or clicking
the Print preview and print button on the toolbar.
A Print options dialog window appears where printer selection and printer settings can be made and

other common print options can be set. Click OK to continue.

i Print
[ General |

Select Printer
% Add Printer
EiFax
[#% Microsoft XS Document Writer
Status: Ready [] Printtofie | Prefersnces
Location: =
T Find Priter |
Page Rangs
@ Al Number of copies: 1

Selaction Curert Pags

Pages Collate

111 22)| 33
The pri nt preview screen appears:
Frem e S
g, w 8 &8+ a .

.......

With use of the toolbar on this screen the following functions can be accessed:

Zoom tool
O T} [j The print preview page can be zoomed to fit the screen height (Zoom to fit), to fit
the screen width (Zoom to width) and to the original size (100%).

Navigation tool

- - = =

This tool can be used to navigate to the First page, Previous page, Next
page or to the Last page of the medical report.

Search tool
With use of these tools a search can be performed by page number (Go to page) or by

(3
a keyword (Search for text).
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Copy tool
n The current page of the report can be copied to clipboard with this tool.

Print tool
& &

A printer can be selected an set up with use of the first icon. The page can be printed
with the previously determined settings by clicking on the second icon.

Load / Save tool
- The Report can also be saved in a file by clicking on Save report. The destination
directory and the name of the saved file can be selected in a pop-up dialog window.

Note: This procedure generates a QuickReport file (.grp), which can be viewed only in the
TensioMed SW.

The patient’s previously saved Reports can be selected and displayed by clicking on Load Report in
the Print preview dialog box.

Close

s The Print preview screen can be closed by using this button.

The Report printed out by the Medexpert Software will contain the following:

f avnart Blood Pressure Measurement f avnart X Pulse Wave Analysis
!rj!] ’.'!TL.,E’.\.. XPe Arteriograph report and Pulse Wove Analysis !rl‘-] m»e;g #Pe Arterfograph report and Arterial Age Assessment
Name Postal code: 1035 Country code:  HU Name: 0 007
o w7 City Hudapest Date of Birth:  1949/05/09
Date of Prth:  1949/05/09 Addreis Age: 61 yoars Gender Male
Age: £1years Teleghone:  +36 1250 4420 "
Gender: Male E-mail siteriograph@medexpert hu
Weight, BMI 1104 318 kg/m2 Qualty control
R A s0: 0.14 mi
faenily history of CVD \ 7
I\ TG
e / N, |
J S, = h_T
S Y, s
Medication 200 mwiem ] 19
nene Pulse Wave Velocity measurement
Py B mfs Lid 147 s
Measuremaent data PWV - Arterial Age Assessment
Date: 2013/04/01 10.05 Height 186em  Armirc:  ¥lem Right PWVso
Operator:  ARTERIOGRAM JugSv: 58cm  Cuff sive 2 "
Suprasystolic record hat
. AT 5M e i J re s
Contral Hemodynamics ™
LA sabysis i
Sy $8Paa; 111.2 mmig i
Dl T
PP PPac 30.2 mmhg i,
n MAP: 95 mmtig f .
13 HR 63 /min x
Al brachial 55.5 % Bix soetic 9.6% ]
= Al brachial [75) 62.2 % Adx wortic (75]. 28% 5
Lower lemb circulathon Tiection duration
200 mwes ABL ED 320 ms
w o 0 N ¥ 0 awn @ M 70T N E W W
\ DR 60 a3 Auterial age: ~80-50 yesrs*

@ > 90th percentile
O =508 <= 90th percentile
@ <= 50th percentile

Age (years)

TensioMedT Saftware  +.3.00.0 BETA
1/TIOLL4 00219

\.]I\|iL‘-J L\ a5 %
.] J |y LA / — PWV (/)
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Page 1:

Page 2:

Patient details. The data specified when entering the patient’s data are shown here including

a user-defined parameter and its value provided it is set (Section 5.4.1). The space for

missing or undefined data will remain blank.

Risk profile. The previously entered risk profile (see Section 5.4.2.2) appears here.

Medication. The list of medications entered previously (see Section 5.4.2.2) appears here.

Measurement data. This part contains the date and time of the examination, the name of

the operator, and the mandatory patient data.

Suprasystolic record. Peripheral and central hemodynamic parameters are listed here,

excluding pulse wave velocity. The calculated Ankle-Brachial Index (ABI) is also represented

here, if this option was selected (see Section 5.4.1). A characteristic pulse wave is shown with

the points of the Return Time (RTS35) and Dicrotic notch (Ejection Duration; ED) indicated on

it. The return time does not necessarily fall to a characteristic point on the curve (see Section

5.4.4).

Diastolic record. This part contains the parameters resulting from the analysis of the pulse

wave curves recorded at the diastolic pressure step. There are also two graphs showing a

section of the pulse wave curves and a single curve (the last wave if several waves are

selected for analysis). The DRA, SAIl, and DAI parameters can be defined only if an ED value is

available from the previous phase (Suprasystolic record).

Footer:

- Institutional and operator data on the left-hand side, if set (Section 5.4.5.1).

- Manufacturer’s data complemented with the version number of the SW on the right-
hand side.

Suprasystolic record. The first part of this page contains the quality control of the
measurement. A section of pulse wave curves recorded on the suprasystolic pressure step
are shown in a graph to enable visual control over the quality of the waveforms. The value of
SD PWVao is also represented here.

Pulse Wave Velocity measurement. This part highlights the measured aortic pulse wave
velocity and return time values.

PWYV - Arterial Age Assessment. The current measurement is placed in an age — PWVao
graph with smoothed reference percentile curves (see Section 5.4.4.3). The point of the
measurement is coloured according to the ranges in the graph legend. The estimated arterial
age of the patient is also given here in decades except for pooling over the vascular age of
60. A more precise estimation of the patient’s arterial age can be seen on the SD PWVao
parameter graph, which is a simplified visualization of the reference percentile values for the
patient’s age. It shows the patient’s position relative to the reference population. The
measured value is indicated in the graph, also showing the estimated arterial age at the top.

Page 3 (optional):

Medical Report. Printed only if the Edit report function was used (see Section 5.4.5.1). This
page includes only the patient details and the edited medical report.
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Note: The Report is always printed out in A4 size. It will contain only as much information as was
entered previously or was calculated in the course of the analyses, which also means that a
Report can be printed out with only the patient’s data appearing.

Note: Cut-off (critical) values for the different parameters can be found in the available scientific
literature addressing vascular age and arterial function.

5.4.6.3 How to send a Report in PDF format

You can convert the above detailed Report to PDF format by Send PDF Report under the File menu
and simply e-mail it. After the command is selected, the program converts the Report to PDF format
automatically. The generated .pdf file can be saved to a selected destination with the following file
name: Tcrep_fullname_date_time.pdf, where fullname is the name of the patient and date and time
are the date and time of the examination in the pre-set date and time format (e.g.
TCrep_TestElisabeth 26032007_07_43.pdf).

As a next step the default e-mail client — if there is any — on the PC is loaded automatically with the
generated .pdf file attached to a new letter.

5.4.7 Exporting the measurement data

Formerly saved measurement results (see Section 5.4.4) can be exported into a formatted text
file by choosing Export data under the Tools menu or clicking the Export data... button on the
toolbar.

Step 1 Select a User whose patients’ measurement you would like to export by clicking the
checkbox next to it. The Select all option is a quick way to select all the listed users. All
the registered users are listed in this window. Selection is confirmed by clicking on the

arrow.
Export data. ===
1. Srep:
Plansn solaed weens)
B AATERIGRAM Deiare Reshsizntiz |
il
&
Step 2 Select the patients whose measurements you would like to export by clicking on its row.
All the patients belonging to the selected user are listed here in alphabetical order of the
family name.

In case there is a great number of patients, a particular patient can be found by using the
built-in search function. For a quick search click anywhere in the patient list and type in
the initials of the family name of the given patient. The built-in search is not case
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sensitive.

Multiply selection can be done in the common Windows way (using Ctrl or Shift while
clicking). The Select all option is a quick way to select all the listed subjects. Selection is
confirmed by clicking on the arrow.

Export data_ ===
&
2. Step:
Please solact pationi{s)
&
Coancal med.
Step 3 By setting a time range here, only those measurements that were performed in the

specified range will be exported. By selecting Export all measurements, every
measurement of the formerly selected patients will be exported. Click Export to start the

process.

[export anea_ [ ]

&
et all
g
Export oll measurements Lyt
Lancel med
Step 4 The status of the export process is shown by a progress bar. In case of a large database
the process can take several minutes.

Export data...

Export patients data...

— ]

Export measurements...

— |

“dimed
Step 5 When the export is completed a message window will pop up confirming on the
successful save.

E¥ information S

|\i) File saved successfully!

8 mede>
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The save destination of the completed text file can be selected. The exported file is a tab delimited
text file, which can easily be opened or imported in common spreadsheet applications (e.g. Microsoft
Excel) or statistical packages (e.g. SPSS, SAS).

Note: The exported text file contains each measurement in a different row. Several
measurements for one patient are listed under each other. If the result were not saved for a
given measurement the exported text file will only contain the patient characteristics and the
blood pressure measurement data in that row.

5.4.8 Backup and restore the database

To protect your measurements against accidental data loss, the database should regularly be backed
up. For this use the Backup command under Tools menu.
The Backup and restore dialog window appears, where you can set whether to make or to restore a
database. The destination directory can also be selected.

5.4.8.1 Backup data

In the Backup field select Make to start the backup process. Also select the destination directory for
the backup file.

Backup and restore database [
Backup Place of backup fie
© Make =1 c: [packard bell] -
*) Restore =c
(£ Windows
3
£ 0409
£ Advancedinstallers
£ ar-sA
£7bg-BG
(£ catroot
() catrootz
£ com
{5 config
stz
£ daDk
£ de-DE
£ Dism i’
Start Cancel V8l medexpert

In case there is a previously saved backup file in the selected database, a confirmation window pops
up for overwriting the file. If you don’t want to overwrite it, press No and rename the previous
backup file or choose another destination directory. If you approve overwriting, simply click on Yes.

2 Confirmation @

@ Backup file already exists! Do you want to overwrite it?

¥l mec

An information window appears if the backup is successfully completed.

U Information @

@ Backup completed!

718 med;
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5.4.8.2 Restore data

In the Backup field select Restore to start the restoration process. Also select the destination
directory for the backup file.

Backup and restore database [

Backup

Place of backup file
© Make = d: [data]
@ Restore =D\
£ CCleaner
£ nokia

B medsxpert

A confirmation window pops up for approving the restoration. Simply press No to cancel the process
To start the restoration, click on Yes.

) Confirmation ﬁ

@ Are you sure you want to restore the database?

An information window appears when the restoration is successfully completed.

) Information ﬁ

@ Data restore completed!

/8 medexpert |

5.4.8.3 Import previous database

If you have a previous version of Arteriograph database on your computer the Convert previous
database and import data command under Tools menu helps to convert the measurements into the
new database format.

Select the patient list (.pat) file in the Regisztratumok folder under the previous installation directory
(by default: C:\TensioClinic\Regisztratumok) and click Open to start the import procedure.

Note: Only a database in the original installation folder can be imported.

Note: For a large database the conversion can take several minutes. The status of the procedure
is shown by a progress bar.

Successful conversion is confirmed by a pop-up window.

B Information

\\i‘) Data import has been successfuly done!

98
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6. Troubleshooting

Problem

Possible causes

What to do

No communication

Communication adapter is not
connected

Plug in the adapter and follow the
instructions of Section 2.5.

The device is not recognized by the
PC

Go to Control Panel/Telephones
and Modems/Modems and check
whether the device is present. If
not, follow the instructions of
Section 5.2.

No or low batteries in the device

Replace the batteries.

The device was turned off

Turn on the device by pressing its
button twice.

No arterial function
parameters are
displayed

Loose cuff Tighten the cuff.
The method cannot reliably assess
Arrhythmia arterial function parameters in
arrhythmic patients.
If ibl i
Tremor possible, try to terminate

tremor.

No print preview

No printer have been installed to
the PC.

Install a printer or use the built-in
virtual printer of Windows.

The PDF report cannot
be opened

Adobe Reader is not installed to
the PC.

Download and install the latest
version of Adobe Reader.

Database import
cannot be completed

Not the proper database was
opened or the database was
damaged.

Import the database by following
the instructions of Section 5.4.8.3.

Cannot send e-mail
successfully

Error messages

Error codes, as shown on the LCD, and their explanation are specified below. It
should be noted that errors can occur due to patient movement causing artefacts ‘E
in the reading. In case the Device cannot measure blood pressure (e.g. due to

No e-mail client is installed to the
PC.

motion), measuring will be disrupted.

Install an e-mail client and set it to
be the default one.

Example:

32

The codes of the error flags indicated by the Device shall mean the following:

1 “measuring time exceeded” The Device could not measure the patient’s blood pressure
within the pre-set time.

3 “low battery” Measuring was disrupted because of low battery.

31 “cuff missing” The cuff is not connected to the Device.
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32 “cuff clogged” The rubber hose of the cuff is blocked or something is choking
the hose.

33 “air leakage” The cuff (or the Device) leaks.

34 “the cuff is not on the arm” While connected to the Device, the cuff is not put on the
patient.

35 “measuring disrupted” For some reason (e.g. the user presses the button) measuring is
disrupted.

90-99 “Device error” Blood pressure measuring failed for some Device error or the
battery is low.

100 “Faulty measuring result” The calculated results cannot be considered as a real blood
pressure value or the patient is having arrhythmia.

101 “motion” The measuring conditions, e.g. the patient’s movement,
interfere with the process of measuring.

102 “no pulse detected” For some reason the Device does not detect the cardiac pulses.

110 “Faulty measuring result” The signals are insufficient for blood pressure calculation.
(Artefacts, arrhythmia.)

111 “Faulty measuring result” The calculated results cannot be considered as a real blood

112 pressure value. (The most likely reason is noisy measurement

113 signals.)

115 “Faulty measuring result” The pulse rate cannot be calculated or cannot be considered as

a real value.
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7. Technical Specification

Power supply:
Four AA long-life alkaline batteries or rechargeable batteries
Protection against electric shock:
Internal supply by batteries
Grade of protection against electric shock:
BF type on patient’s side
Display:
Liquid Crystal Display (LCD)
Data storage:
EEPROM
Data transmission:
Wireless, infrared
PC Interface:
IrDA Communication Adapter
PC system requirements:
Windows XP with Service Pack 2 or newer OS installed
Ambient temperature:
10-40°C
Dimensions:
116 x 94 x 47mm
Weight (incl. batteries):
250g
Blood pressure measuring method:
Oscillometric
Sampling frequency:
200Hz
Blood pressure measuring limits:
30 - 280mmHg
Static accuracy:
+ 3mmHg or +2% of the measured value (Stability: 2 years)
Measuring accuracy:
Systolic:
91 (91%) out of 99 comparative checks fall within 5 mmHg,
For 33 patients out of 33, 2 of 3 comparative checks fall within 5 mmHg,
0 of 33 patients did not have a value within 5 mmHg after 3 measurements.
Diastolic:
97 (98%) out of 99 comparative checks fall within 5 mmHg,
For 33 patients/33, 2 of 3 comparative checks within 5 mmHg,
0 of 33 patients did not have a value within 5 mmHg after 3 measurements.
Average deviation from auscultatory measurements (Korotkov sounds):
(systolic/diastolic): 0.4/-0.3 mmHg
Standard deviation (systolic/diastolic): 2.7/2.3 mmHg
Pressure sensor:
Piezo-resistive
Inflation:
Automatic motor-driven pump
Safety:
Maximum cuff pressure: 280mmHg
Deflation:
Automatic, stepwise
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7.1 Electromagnetic compatibility

Electromagnetic emissions

The TL1 device is intended for use in the electromagnetic environment specified below. The customer or the user of the TL1 device
should assure that it is used in such an environment.

Emissions test Compliance Electromagnetic environment - guidance
RF emissions Group 1 The TL1 device uses RF energy only for its internal
CISPR 11 function. Therefore, its RF emissions are very low and

are not likely to cause any interference in nearby
electronic equipment.

RF emissions Class B The TL1 device is suitable for use in all establishments,
CISPR 11 including domestic establishments and those directly
Harmonic emissions Not applicable connected to the public low-voltage power supply
IEC 61000-3-2 network that supplies buildings used for domestic
Voltage fluctuations / flicker emissions Not applicable purposes.

IEC 61000-3-3

Electromagnetic immunity

The TL1 device is intended for use in the electromagnetic environment specified below The customer or the user of the TL1 device should
assure that it is used in such an environment.

Immunity test IEC 60601 test level Compliance level EIectromagne.tlc environment -
guidance
Electrostatic discharge (ESD) + 6 kV contact + 6 kV contact Floors should be wood, concrete or ceramic
IEC 61000-4-2 + 8 kV air + 8 kV air tile. If floors are covered with synthetic
material, the relative humidity should be at
least 30 %.
Electrical fast transient/burst + 2 kV for power supply lines Not applicable
IEC 61000-4-4 + 1 kV for input/output lines
Surge + 1 kV line(s) to line(s) Not applicable
IEC 61000-4-5 + 2 kV line(s) to earth
Voltage dips, short interruptions | <5% Ur Not applicable
and voltage variations on power | (>95% dip in U+)
supply input lines for 0,5 cycle
IEC 61000-4-11
40% Uy
(60% dip in Uy)
for 5 cycles
70% U¢
(30% dip in Uy)
for 25 cycles
<5% Ur
(>95% dip in Uy)
for5s
Power frequency 3A/m 3A/m If image distortion occurs, it may be
(50/60 Hz) necessary to position the TL1 device further
magnetic field from sources of power frequency magnetic
IEC 61000-4-8 fields or to install magnetic shielding. The
power frequency magnetic field should be
measured in the intended installation
location to assure that it is sufficiently low.

NoTE: Uy is the AC mains voltage prior to application of the test level.
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Electromagnetic immunity

The TL1 device is intended for use in the electromagnetic environment specified below. The customer or the user of the TL1 device
should assure that it is used in such an environment.

Immunity test IEC 60601 test level Compliance level | Electromagnetic environment — guidance

Portable and mobile RF communications
equipment should be used no closer to any part of
the TL1 device, including cables, than the
recommended separation distance calculated from
the equation applicable to the frequency of the
transmitter.

Recommended separation distance

Conducted RF 3 Veit 3V d=1,2vP

IEC 61000-4-6 150 kHz — 80 MHz

Radiated RF 3V/m 3V/m d=1,2vP 80 MHz — 800 MHz
IEC 61000-4-3 80 MHz - 2,5 GHz d=2,3vP 800 MHz — 2,5 GHz

where P is the maximum output power rating
of the transmitter in watts (W) according to
the transmitter manufacturer and d is the
recommended separation distance in metres
(m).

Field strengths from fixed RF transmitters, as
determined by an electromagnetic site
survey,” should be less than the compliance
level in each frequency range.h

Interference  may occur in the vicinity of
equipment marked with the following symbol:

((?)

NOTE 1 At 80 MHz and 800 MHz, the higher frequency range applies.

NOTE 2 These guidelines do not apply in all situations. Electromagnetic propagation is affected by absorption and reflection from
structures, objects and people.

? Field strengths from fixed transmitters, such as base stations for radio (cellular/cordless) telephones and land mobile radios, amateur
radio, AM and FM radio broadcast and TV broadcast cannot be predicted theoretically with accuracy. To assess the electromagnetic
environment due to fixed RF transmitters, an electromagnetic site survey should be considered. If the measured field strength in the
location in which the TL1 device is used exceeds the applicable RF compliance level above, the TL1 device should be observed to verify
normal operation. If abnormal performance is observed, additional measures may be necessary, such as re-orienting or relocating the
TL1 device.

® Over the frequency range 150 kHz to 80 MHz, field strengths should be less than 3 V/m.

Recommended separation distances between portable and mobile RF communications equipment and the
TL1 device

The TL1 device is intended for use in an electromagnetic environment in which radiated RF disturbances are controlled. The customer or

the user of the TL1 device can help prevent electromagnetic interference by maintaining a minimum distance between portable and

mobile RF communications equipment (transmitters) and the TL1 device as recommended below, according to the maximum output
power of the communications equipment.

Separation distance according to frequency of transmitter
Rated maximum output m
power of transmitter 150 kHz — 80 MHz 80 MHz — 800 MHz 800 MHz — 2,5 GHz
w
d=[3,5/3]vP d=[3,5/3]vVP d=[7/3]vP

0,01 0,12 0,12 0,23

0,1 0,38 0,38 0,73
1 1,2 1,2 2,3

10 3,8 3,8 7,3

100 12 12 23

For transmitters rated at a maximum output power not listed above, the recommended separation distance d in metres (m) can be
estimated using the equation applicable to the frequency of the transmitter, where P is the maximum output power rating of the
transmitter in watts (W) according to the transmitter manufacturer.

NOTE 1 At 80 MHz and 800 MHz, the separation distance for the higher frequency range applies.

NOTE 2 These guidelines may not apply in all situations. Electromagnetic propagation is affected by absorption and reflection from
structures, objects and people.
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